
































































































































































































































































































































































































































































































































































































































































































































































372 What Do I Do Now? 

Row heights and column 
widths in CJarisWorks 
are expressed in points-
72 points equal an inch. 

Solution: Format the cell to wrap the 
text. Select the cell (A4 in the ex­
ample above), then choose the Wrap 

command from the Alignment 
submenu off the Format menu. The 

text wraps down to a second line inside the cell. You won't be able to see the 
second line without making the row taller, however. To make the row taller, 
choose the Row Height command and enter a larger value for the row height. 

{1iJ Some cells oro locked. Problem: You've tried to move, paste, 
sort, or enter data in a cell, but 
ClarisWorks displays a message 
saying that some cells are locked. 

Solution: Select the cell you want to unlock and then choose Unprotect Cells 

from the Options menu. 

After sorting, the labels in a spreadsheet column 
no longer match the values in adjacent columns. 

A 0 C D E Problem: In some spreadsheets you 
sort entire spreadsheet rows, but 
ClarisWorks allows you to sort 
individual groups of cells. As a result, 

you can rearrange cells in one column without affecting the cells in other 
columns. (Compare the example above with the one on page 371.) 

Solution: Always check out the Range box in the Sort dialog box to see which 
groups of cells you're about to sort, and make sure you're sorting the cells 
you want. If you perform a sort and it's not what you want, choose Undo Sort 
immediately from the Edit menu to put things back the way they were. 

You can't see the page breaks in a spreadsheet. 

Problem: ClarisWorks only displays its standard page breaks in a spreadsheet 
document when you're using page view. If you insert manual page breaks, on 
the other hand, they are indicated with dashed lines whether you're in page 
view or not. 

Solution: Choose Page View from the View menu. You see the page margins 
and the breaks between pages. 
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Data from rows is used for each chart series, and you 
wanted data from columns used for each series. 

Problem: ClarisWorks and most other 
spreadsheets assume that the largest 
number of data points should be 
used as series (the x-axis labels 
above), while the smaller number 
should make up the values within 
each series (the bars above). 

Solution: Choose Modify Chart from 
the Options menu, cl ick the General 
button at the left side of the dialog 
box, and then click the Series in 
Columns button. 
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You want to change the color or pattern of a bar or pie slice in a chart. 

Problem: ClarisWorks' chart modifica­
tion options don 't offer any way to 
change a chart's colors or patterns. 

Solution: Copy the chart to a draw 
document, choose Ungroup Picture 
from the Arrange menu to break the 
chart up into its component bars or 
pie slices, and then select the bar or 
slice you want and choose a different 
pattern or color for it from the tool 
palette. 

When you paste a chart 
into a draw document 
and choose the Ungroup 
Picture command, 

ClarisWorks doesn't break up 
smaller components like the pat­
terns and text inside a chart's leg­
end. To break up these elements fur­
ther, select the object and then 
choose Ungroup from the Arrange 
menu. 
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The database 
You see parts of two or more records on the screen at once. 
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Problem: ClarisWorks' default display 
mode is to show records in a 
scrollable list, as shown above. 

Solution: Choose List View from the 
Layout menu to remove the 
checkmark from this command. You 
then see only one record at a time. 

You're trying to find information, but the Find/Replace window doesn't allow you 
to search for information in specific fields. 

rlnd/Chon~o Problem: The Find/Replace command 

1,;.~1 'n;.:..d ------.
1 1

Fc".:...con-""9"-----.
1 

on the Edit menu is a global feature 
0 Whole word 0 Coso sonsltluo that works in most ClarisWorks 
( Ch0119H fill I [ ChOII!JC I [rhuni)O. Find I I lind Nont I document types. It lets you search 

for text anywhere in the document. 
In the database, however, you use the Find mode to search for data in specific 
database fields. 

Solution: Choose Find from the Layout menu to use the database's Find mode. 

You added a header or footer to a layout, but now it appears in every layout, 
rather than just on the one where you added it. 

Problem: The Insert Header and Insert Footer commands on the Format menu 
work with any ClarisWorks document. In the database, these add a header or 
footer to every layout in your database document, not to a particular layout. 

SoluUon: To add a header or footer to a particular layout, choose the layout 
name from the Layout menu (to display that layout), Choose Layout from the 
Layout menu (to switch to Layout mode), and then choose the Insert Part 
command from the Layout menu to add a header or footer part to that par­
ticular layout. 
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You want to insert a second copy of a field on a layout, but the Insert Field 
dialog box doesn't show the field name, and nothing happens when you try to 
copy the field in Layout mode. 

Problem: You can't have more than one copy of a field on any layout in the 
ClarisWorks database. 

SoluUons: 

• If you're trying to add another calculation formula to a layout (placing 
the same total formula in both a sub-summary and grand summary 
part, for example), simply define a new calculation field with the same 
formula and a slightly different name. For example, you could name 
one field GRTOTAL and the other SBTOTAL. 

• If you need to use multiple copies of the same field (using the 
FirstName field twice in a form letter, for example), switch to FileMaker 
Pro, which has no problem with multiple copies of the same field in a 
layout. 

The drawing program 
It's hard to keep lines straight when you drag an endpoint to resize them. 

Problem: You have to keep the mouse on the same plane as the line itself in 
order to maintain a straight line when you drag one of its endpoints. Other­
wise, the line becomes jagged. 

Solution: Hold down IShittl as you drag the line's endpoint. This keeps the 
pointer on the same path as the original line. 

You want to draw an arc that has a different angle than 90 degrees. 

Problem: The default setting for arcs is a start angle of 90 degrees and a total 
angle of 90 degrees, so you're limited as to the position of every arc you draw. 

SoluUon: Draw the arc, then leave it selected and choose Modify Arc from the 
Options menu. Then you can change the arc's start angle and total angle 
(called the Arc Angle in the dialog box) by entering new values for them. 
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Shapes you draw cover up objects beneath them. 

Problem: The default fill color for shapes is white, and the default pattern is 
opaque. Since the Mac's screen is white, it looks as if you're drawing a trans­
parent shape, but you're not. 

SoluUon: Select the object and then choose the transparent fill pattern from 
the fill pattern palette. If you don't want to change a shape's pattern, select it 
and choose Move to Back from the Arrange menu to put it in a layer behind 
anything else it was covering up. 

You've changed a fill pattern or line attribute, but after you draw the current 
object it changes back to what it was before. 

Problem: If you have an object selected when you change a fill or line 
attribute, you change it only for that object. 

Solution: To change the setting so it's the same for all new objects, choose the 
setting when no objects are selected. 

The painting program 
A new paint document is too small, or you get 
out-of-memory messages as you use a paint document. 

ll':ll The document size has been reduced to m the 
~ ouelloble memory. 

Problem: There's not enough memory 
to make the document larger or to 
allow you to continue working with 
it. Paint documents use a lot of 
memory, and the document size 

depends on how much memory is available at the time. If you have no other 
documents open, the' document size is one full page. 

Solutions: 

• If you see a message like the one above, open the document anyway, 
choose the Document command from the Format menu, and try enlarg­
ing the document by changing its size in the Document dialog box. 
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Paint documents can 
only be one page no 
matter how much 
memory you have. If you 

• If you get an out-of-memory 
message, close the paint docu­
ment or other documents and 
then try opening a new paint 
document again. 

• If you still can't make the 
document large enough, 

want to create a multipage docu­
ment, use the drawing program. 

choose Resolution and Depth from the Format menu and select a lower 
resolution or a smaller number of colors or gray shades. As you choose 
the options in the Resolution and Depth dialog box, you'll see how 
much memory the document is using-you use less memory with 
lower resolution or depth settings. 

• If you don't want to live with a lower resolution or depth, quit 
ClarisWorks and change its current memory size with the Get Info 
command to allow it more memory space (see page 35). 

You used the paint bucket to fill an object, but 
your whole screen got filled instead. 

Problem: The paint bucket fills any 
enclosed object. If the object isn't 
completely enclosed, it fills your 
whole screen (except for other 
objects that are completely enclosed). 

Solution: Choose Undo Paint from the 
Edit menu to cancel the fill opera­
tion. Then close up the object you 
want to fill and try using the paint 
bucket again. If you have trouble 
closing up an object because you 
can't spot the gap in its border, click 
the zoom-in control to magnify the 
object. 

. . . . . . . . . .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ...... ' . . . . . . . . 
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You moved an image so part of it extends past the edge of the paint document, 
and now you can't get that part back. 

Problem: Anything that hangs off the edge of a paint document is no longer in 
memory once the image is deselected. 

SoluUons: 

• If you haven't selected anything else yet (the selection marquee is 
blinking around the edges of the image that are still visible on your 
document), drag the image back toward the middle of the document. 
The missing part reappears. 

• If you deselected the image but you haven't done anything else yet, 
choose Undo Deselect from the Edit menu. The entire image is selected 
again, and you can drag it back onto the document. 

You darkened an image with the Darker command on the Transform menu and 
now want to lighten it again, but when you choose the Lighter command the 
image doesn't return to its original state. 

Original Darkened Lightened 

To try out effects like 
this, duplicate the 
original image and try 
the effect on the dupli­

cate. That way, you still have the 
original if you don't like the effect 
and can't change it back. 

Problem: The Darker command dark­
ens an image permanently. You can 
lighten the darkened image with the 
Lighter command, but this doesn't re­
turn the image to its original state. 

Solution: If you haven't done any­
thing else since darkening the image, 
choose Undo Darker immediately 
from the Edit menu. Otherwise, 
you're out of luck. 
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The communications program 
You're trying to create and store a log-on macro, but you can't choose the 
Macro Wait command from the Shortcuts submenu. 

Problem: The Macro Wait command tells ClarisWorks to wait for a particular 
log-on prompt from the remote computer. This command is only available 
when you're actually connected to a remote computer. 

Solution: Record the first part of the log-on macro by making a connection to 
the remote computer. Once you see the log-on prompt, select it and copy it 
in the work area, choose Macro Wait, and then paste the prompt into the 
Wait For box in the Macro Wait dialog box. Once you've done this, press 
(Return! and finish recording the macro. 

Working with frames 
You want to add a frame to a database document, 
but the tool panel doesn't show any frame or graphic tools. 

Problem: The tool panel in the database only shows frame and graphic tools 
when you're in Layout mode, because this is the only place where you can 
add frames or graphics. 

SoluUon: Switch to Layout mode and then add the frame. 

You're working in a frame, but it's not large enough and 
there are no scroll bars you can use to view another part of it. 

Problem: Frames don't have scroll bars 
you use to navigate in them. In a text 
or spreadsheet frame, you can actu­
ally move the insertion point or cell 
selection to a part of the frame you 
can't see, and there's no simple way 
to scroll to and view that area of the 
frame 

This technique doesn't 
work in paint docu­
ments. See below. 

Solution: Click once in the document to switch to draw environment. The 
frame should be selected as a graphic object. If it isn't , click on it once to 
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select it. Then drag one of the frame's selection handles to make it larger. Fi­
nally, click inside the frame to move into its data environment and continue 
working. 

You want to work with data in a frame that's in a paint document, but 
the frame's menus don't appear when you click on it. Instead, the pointer 
turns into a pencil. 

A I B 

,__!.._ ................................... ! ....... ~~~~~!::!1 ...... . 
2 Food i 250 

r-!- :~!.~~: :::::::::::::::::: :::r::::f.::::::::::::::?.~Q: 
4 Utilities ! 75 !-- ................................... , ................................. .. 
5 Insurance 1 100 r-:- ................................... , .................................. . 
6 Medica 1 1 50 

Problem: Once you create a frame and click away 
from it in a paint document, the frame is con­
verted to a bitmapped image, and there's no 
way to modify data in it any further. 

Solution: Create a new frame and modify the 
data in it before you click away from the frame. 



Appendix 

Alert 
Message 
Locato~ 

<Disk name> could not be shared, because there Is a shared folder inside it. 239 

<file name> could not be found. 344 

<file name> failed to print to printer. (Error# -192) 209 

<file name> failed to print. Do you want to try to print It again? 208 

<file name> from <program name> could not be printed beca se LaserWriter <name> 
could not be found. Try again? 207 

<folder name> cannot be left in the Trash. Do you want to delete it immediately? 17 5 

<Hard disk name> is an active drive or has open files. 144 

<Program name> prefers <number>K of memory. <Number>K is available. Do you want to 
open it using the available memory? 185 

A disk can only be moved by itself. 170 

A newer item named <name> already exists In this location. Are you sure you want to 
replace the newer item with the one you're moving? 164 

A unexpected error has occurred. 187 

An AppleShare system error occurred. (Please run the Chooser to activate Apple Talk.) 233 

Are you sure you want to remove the applications In <folder name>? 17 6 

Can't initialize this disk. 144 

381 
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Can't load the Finder! 121 

Can't open printer. 204 

Cannot locate the edition, because it is 
missing. 242 

Cannot modify a non-modifiable subscriber. 
243 

Desk accessories in suitcase files cannot 
be opened. To open a desk accessory, drag 
it out of the suitcase file first 182 

Did not encounter RETURNO or HALTO on 
macro sheet 313 

Disks can only be moved onto other disks. 
169 

Error -282 updating the boot blocks. 134 

Folders can not be shared until file sharing 
is turned on using the Sharing Setup control 
panel. Do you want the control panel 
opened now? 231 

Format verification failed. 145 

How many minutes until file sharing is 
disabled? 233 

lmageWriter <printer name>-the "select" 
light is off. Please push the "select" switch, 
then click Continue. 208 

Initialization failed! 148 

Items from shared disks cannot be moved 
to the desktop. Do you want to copy 
<name> to he startup disk? (It will appear 
on the desktop.) 236 

Locked cells cannot be changed. 305 

Macro error at cell <worksheet name, cell>. 
313 

Once an Owner Name and/or a Machine 
Name have been entered, they cannot be 
set back to blank. 232 

One item could not be deleted because it is 
locked. Do you want to delete the other 
items? 174 

Please insert the disk: <name>. 133 

Printing from the Finder is not supported. 
160 

Recorder range is full. 314 

Resource error -192 opening script file <file 
name> on <disk name>. 133 

Save changes to <file name>? 356 

Save changes to access privileges for 
<name>? 232 

Some cells are locked. 3 72 

Sorry, a system error occurred. 182 

Sorry, installation on the selected disk 
<name> failed. 135 

Sorry, your password is incorrect. Please 
reenter it. 235 

Source disk was modified during copy. 172 

There are too many items to drag. Select a 
smaller group and try again. 171 

That cannot be duplicated or copied. 16 7 

That contains items that cannot be 
duplicated or copied. 168 



That is the startup disk; its contents can't 
be replaced. 169 

That name is not valid. 318 

The <program name> document <name> 
could not be opened, because it is in the 
Trash. To use this item, first drag it out of 
the Trash. 161 

The alias <name> could not be opened, 
because the original item could not be 
found. 161 

The application <name> has unexpectedly 
quit, because an error of type 1 occurred. 
189 

The Clipboard could not be read. 187 

The control panel <name> cannot be used 
now, because not enough memory is 
available. 183 

The desktop file couldn't be created on the 
disk <name>. 17 7 

The disk <name> can't be used, because 
an error of type -192 occurred. 154 

The disk <name> can't be used, because 
an error of type -192 occurred. 192 

The disk <name> could not be erased, 
because it is the startup disk, which 
contains the active system software. 178 

The disk <name> could not be put away, 
because it contains items that are in use. 
153 

The disk <name> could not be put away, 
because it is being shared. 239 
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The disk <name> needs minor repairs. Do 
you want to repair it? 148 

The disk is so full that the folder changes 
couldn't be recorded. 153 

The document <name> could not be 
opened, because the application that 
created it could not be found. 158 

The document size has been reduced to fit 
the available memory. 3 7 6 

The drive failed its test. 145 

The driver could not be installed. 145 

The file <name> couldn't be read and was 
skipped (the file is busy). 238 

The file <name> couldn't be written and 
was skipped (unknown error). 171 

The file <name> couldn't be written and 
was skipped (unknown error). 238 

The file server is closing down in 
<number> minutes. 240 

The file/folder could not be renamed. 173 

The folder <name> could not be opened, 
because you do not have enough access 
privileges. 236 

The folder/disk <name> couldn't be opened 
(file server is no longer connected). 239 

The folder/disk <name> couldn't be opened 
(the file/folder is missing). 160 

The Installer did not find any Installer 
documents and cannot run without one. 
132 
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The printer has been initialized with an 
incompatible version of the Laser Prep 
software. To reinitialize and continue 
printing, click OK or click Cancel to stop 
printing. 209 

The selected items are from different disks. 
Please move, copy, or duplicate them 
separately. 171 

The selected items can't all be opened/ 
printed at once. 160 

The startup application on <disk name> 
cannot be set (not a startup volume). 178 

The Trash cannot be moved off the desktop. 
172 

The volume <name> could not be made the 
startup volume (can't switch systems when 
using MultiFinder). 132 

The volume <name> could not be made the 
startup volume (can't switch systems when 
using MultiFinder).163 

The volume <name> could not be made the 
startup volume (Finder is older version). 
162 

The volume <name> could not be made the 
startup volume (System is older version). 
132 

There are no initialized Macintosh volumes 
on this drive. 144 

There are not valid criteria in this request 
Type a valid request before clicking Find. 
348 

There is not enough memory to keep the 
window <name> open. 161 

There is not enough room on the disk 
<name> to copy <file name> (an additional 
<number> MB must be thrown away first. 
165 

There isn't enough Finder memory to 
complete this command. 17 6 

There isn't enough Finder memory to eject 
the startup disk. 152 

There isn't enough Finder memory to work 
with the disk <name>. 152 

There may be items in <folder name> that 
are not visible; try to remove it anyway? 
175 

There's a problem with the disk <name>. 
Installation cannot continue. The disk 
<name> may not be a usable startup disk. 
(Error# -54) 135 

These items need to be stored in special 
places inside the System Folder in order to 
be available to the Macintosh. Put them 
where they belong? 165 

This disk is damaged. Do you want to 
initialize it? 148 

This disk is locked, so you cannot make 
changes here. Do you want to create the 
alias on the desktop? 178 

This file is used by the system software. It 
cannot be opened. 159 

This is not a Macintosh disk: Do you want 
to initialize it? 146 
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This text box or a text box in the group has 
linkages that can't be duplicated. [45] 339 

This version of Font/DA Mover is out of 
date. To install a font, drag it to the System 
file. To put a desk accessory in the Apple 
menu, drag it to the Apple Menu Items 
folder. 214. 

Too many desk accessories on <disk 
name> to install <file name>. 134 

Unable to find a suitable drive connected to 
the SCSI port. 142 

Unable to identify this drive. 143 

Unable to mount volume. 143 

Unknown user or log on is disabled. Please 
retype the name or contact the server's 
administrator. 234 

You are about to start file sharing without 
having given yourself a password, and this 
is not advised. 231 

You are not connected to any file servers. 
238 

You cannot copy <file name> onto the disk 
<name>, because the disk is locked. 167 

You cannot duplicate in the folder <name>, 
because there isn't enough memory 
available. Closing windows or quitting 
application programs can make more 
memory available. 166 

You cannot duplicate in the folder <name>, 
because you do not have the privilege to 
make changes. 23 7 

You cannot move <file name> to the folder 
<name>,becauseitcannotbefound. 166 

You cannot move <file name> to the folder 
<name>, because the disk is full. 166 

You cannot move <folder name> from the 
disk <name>, because the disk is locked. 
175 

You cannot move <folder name> to the 
folder <folder name> because it cannot be 
moved into itself. 170 

You cannot open more than one Finder at a 
time. 163 

You cannot replace the <program name> 
document <name>, because a file cannot 
be replaced by a folder. 170 

You cannot replace the folder <name>, 
because it contains items that are in use. 
168 

You cannot switch launch to an older 
version of the Finder. 162 

You do not have the access privileges to see 
all items in <folder name>; copy the visible 
ones? 237 

You don't have enough access privileges to 
see all the items if they are put into <folder 
name>. Put them there anyway? 23 7 

Your owner name needs to be entered 
before file sharing can be enabled. 231 



32-blt addressing, 50, 106, 261 
400K noppy disk 

using with Mac II, 262 
using with System 7, 153-154 

800 We Fix Macs, 99 
911 Utilities 82, 94 

A 
Abbott Systems, 98 
About171e Fiudercommand, 27, 104, lOS 
About This Maclutosll command, 27, 32-33 

reports 8Mil RAM on Mac LC, 261 
reports RAM use wrong, 179 

AC outlet, 112 
accelerator card, 6 
access privileges, 5 I 
Access Privileges DA, 230 
active program, 28 
ADB port, 8 
ADB connector, bent/broken, 126 
address error, I 21 
Adobe Systems, 89 
Adobe Type Manager (ATM) 

can 't fi nd fonts, 2 16 
description, 18, 89 

Alert!, 95 
alerts, 78-79 
alias 

asks you to Insert a disk, 162 
can't be opened, 16 1 
can't create, 178 
description, 38-39 
finding o riginal of, 37 

Aldus PageMaker 
adding gray shades to Fill menu, 329 
Aldus Filters Folder, 325 
auto line leading, 327 
background printing disabled, 329-

330 
bit mapped graphics, 329 
can't sec entire pasteboard, 323 
canceling story placement, 325 
changing a text wrap boundary, 328 
changing new document defaults, 

323 
Column guides command, 326 
Copy Master Guit/es command, 328 
Defiue colors command, 329 
exiting nested d ialog boxes, 323 
Iiles larger than normal, 322-323 
Fill menu changes, 329 
Fit in window command, 323 
full-bleed layouts on a LaserWriter, 

327 
graphic distorted when resized, 329 
gray shade not on Fill menu, 329 
Inconsistent line leading, 327 
lndents(fabs command, 325 
Irregular text wrap boundary, 328 
Items don't print with Proof Print, 330 

master page different fro m regular 
page, 328 

pasted lines have unequal offsets, 327 
PICT2 graphic not displayed, 324 
Place command, 325 
Preferences command, 322 
Print options reset when document 

opened, 330 
print job crashes printer, 331 
printing with LaserWrlter d river, 329-

330 
problems saving with At Ease, 324 
Proo(Print optlon, 330 
redudng file sizes, 322-323 
resizing a linked text block, 326 
ruler guides don't change, 328 
screen redraws slowly, 322 
service bureau prints with wrong 

fonts, 331 
Sto ry Importer fi lter, 324-325 
Text Wrap command, 328 
text is squashed or misaligned, 325 
text wrap boundary, 328 
unlinking a linked text block, 326 
upgrading, 321, 324-325 
varying space between columns, 326 
version 4.0, 4.0.1 on a Mac Quadra, 

324-325 
ALSoft, 90, 92 
ALSoft Power Uti lities, 92 
America OnLine, 249 
Apple Communications Toolbox, 249-250 
Apple Computer, Inc., 92, 93 
Apple Display Card, 276 
Apple File Exchange, 147 
Apple HD SC Setup, 91 , 142 
Apple menu 

changing. 58, 59 
open program names on, 29 

Apple Menu Items folder 
description, 13 
Installing/rem oving Items In, 28, 58 

Apple Modem Tool, 137, 250 
Apple Photo Access extension, I 50- 15 1 
Apple TechStep, 92 
AppleTalk file, 137 
AppleTalk network 

connecting, 8 
with Power Book connected, 27 1 

AppleTalk Remote Access, 25 I, 258, 268 
AppleTalk off when printing, 208 
Application menu 

description, 28 
flashing Icon, 78 

Index 
application memory 

changing size of, 35-36 
use, 27, 33 

application programs 
can't open file, 189 
can't print from Finder, 160 
changing memory use, 35-36 
deleting, 176 
description, 10 
determining versions, 104 
erro r during Installation, 136-137 
error when saving a file, 190 
extension connlcts during Installa-

tion, 136 
finding serial number, 11 7 
how they request memory, 35 
installing, 136-139 
limit to number open at once, 28 
making new files/documents with, 

22-23 
memory sizes, 35-36 
not enough memory to open, 185 
opening at startup, 20 
opening files/documents with, 22-23 
opening, 22 
opening/ managing under System 6, 

28-29 
opening/managing under System 7, 

27-28 
quit unexpectedly, 186, 189 
reinstalling, 108 
replacing fi les during Installation, 

137-139 
restarting. 106 
run more slowly than usual, 191 

At Ease 
can't save to a floppy disk, 304, 324 
description, II 
diffetence from Finder, 22 
forgotten password, 264 
loaded at startup, 20 
removable hard disk problems, 263 

At Ease Setup control panel, 304 
ATM (see Adobe Type Manager) 

audio diagnostic tools, 92-94 
Auto Line(eed On Rctum setting, 256 
Auto Remounte.r contro l panel 

description, 51 
problems on network, 2 71 
using, 222 

AulD Wrap to Next Line setting, 256 
available disk space in list view, 48 
avaUable memory, determining, 32 

387 



388 What Do I Do Now? 
8 
background printing, 25-27, 
backup copies, 70-71 , 73 
backup programs, 88 
Battery control panel, S 1-S2, 267 
baud rate, 249 
bend radius, 63 
Bernoulli Box Icon missing, IS I 
boot blocks, erro r updat ing, 134 
Brightness desk accessory, 52 
"Bus error." 12 1 
buzzing noise during crash, 80 

c 
cable connectors, bent pins in, I l l 
cables, squashing/stretching, 63, Ill 
Can0pener2, 98 · 
Capture, 14, 
Captllre Text command, 2SS 
Caravelle Networks Corp., 97 
Casa Blanca Works, 91 
Casady & Greene, 89, 98 
CD-ROM disk 

description, 7 
no icon on desktop, I SO-I 5 I 
Mac won't start up fro m, 125 

cdevs (Control Panel devices) 
description, 14-16 
displaying In Control Panel DA, 4 1 
installing under System 6, 28 
using under System 6, 28, 41 
won't work properly, 184 

CESoftware, 90 
Central Point Anti-Virus, 96 
Centra l Point Software, 88, 93, 94, 9S 
Chooser DA 

with Powerllook Duo, 269 
opening/using, 25, 42-43, 221 
problems with, 20·1-210 
wrong printer selected, 208 

Chooser extensions 
description, II, 14,42-43 
not installed, 20S-206 

Chooser resources 
description, I I, IS 
not insta lled , 205-206 

Chooser window 
icons in, 14 
no printer icon, 20S-206 
no printer name, 205-207 

CJS Systems, 99 
Ciaris folder, I 38 
ClarisWorks 

adding spreadsheet rows/columns, 
371 

arcs d ifferent than 90 degrees, 375 
bug in versions 1.0 and t.Ov2 
changing an arc's angle, 375 
changing chart pat1erns/colors, 373 
chart displays data improperly, 373 
Cl.arisWorks Stationery folder, 368 

column width measurements, 372 
columns in word processor, 370 
command/menu not available, 369 
copying fi elds in a database, 375 
Darker comman d, 3 78 
DoCIIment command, 370, 371,376 
Edit Slrortwts command, 369 
enlarging a spreadsheet, 37 1 
fi ll/ line settings revert to defaults, 

376 
Fiud command, 374 
Fltui/Replace command, 374 
frame isn't large enough, 379 
frames in database documents, 379 
frames in paint documents, 380 
graphic affects Une spacing, 371 
headers/footers in database, 374 
identifying shortcut icons, 368-369 
image lost in paint document, 378 
indents wrong on StyleWriter, 369 
lusert Part command, 374 
lusert Time command, 370 
inserted time is wrong, 370 
label too wide for a cell, 3 71-3 72 
Uglrter command, 378 
lines crooked when resized, 37S 
List View command, 374 
Macro Wait com mand, 379 
margins in word processor, 370 
maximum spreadsheet size, 37 1 
memory problems, 376-377 
Modify An: command, 375 
Modify Chart command, 3 73 
modifying spreadsheet cells, 3 72 
Mot•e to Back command, 376 
Open command, 368 
opening non-ClarisWorks flies, 368 
Page View command, 372 
page breaks in spreadsheet, 372 
paint bucket fills too much, 377 
paint documents too sm all, 376-377 
paint frames in word processor, 371 
recording a log-on macro, 379 
Resolution aud Depth command, 377 
Row Heigllt command, 372 
row height measurements, 3 72 
shapes cover up other shapes, 376 
Shortcuts palette, 368-369 
Show Slrortcuts command, 369 
sorting spreadsheet cells, 372 
spreadsheet cells arc locked, 372 
Stationery menu, 368 
Text Wrap command, 371 
Undo Darkercommand, 378 
Undo Deselect command, 378 
Undo Pai11t command, 377 
Undo Sort command, 372 
Ungroup command, 373 
Ungroup Picture command, 373 
Uuprotect Celts command, 372 
viewing database records, 3 74 

viewing shortcut names, 368-369 
Wraf1 command, 372 

Clipboard 
couldn't be read, 187 
description, 15 
file, 15 
reducing memory use, 183 

Close View crashes, 276-277 
Close View utility, 276 
color monitor, thin lines on, 276 . 
colo r Quicl:J)raw, 281-282 
colo rs 

how many displayed, 105 
Mac won't display, 198 

communications buffer, 2S5 
communications card, 7 
communications devices, 8 
communications method, 248-249 
communications problems 
(sec also, Microsofl Works, ClarisWorks) 

carriage returns in received file, 2S7 
double characters, 254 
garbled characters, 2S3-254 
lines don 't end a t right places, 256 
lines too long to transmit, 256 
memory warning messages, 25S 
no text on screen, 254 
text won't wrap to next line, 256 
tool doesn't appear on menu, 255 
"serial port in usc," 258 

communications protocols, 249 
comrnunlc;tlions software, 248 
Com patibility Checker, 95 
CompuServe, 249 
Con flier Catcher, 89 
connecting components, 8, 62 
Connccllx Corp., 90 
Connectlx l'owerilook Utili ties, 90 
Control Panel DA 

shows wtong date/time, 184-1 85 
using, 41-42 

Control Panels fo lder 
alias for, 38 
description, 13- 14 
Items loaded at startup, 20 
opening Items from, 28 

control panel programs 
activating on the desktop, 28 
described, II , 44 
Incompatibility problems, 122-123 
not enough memory to usc, 183 
opening/managing multiple, 28 
sto ring/opening, II 
won't work properly, 183, 184 

cooling vents, 62 
coprocessor, 6 
"Coprocessor not Installed." 121 
CPU (central processing unit) 

description, S 
funny noises or smells from, 76 



crackling noise during crash, 80 
Crash Barrier, 98 
crashes, 80, 103 
Create Pub/islrcr command, 24 1 
CSG Technologies, 97 
Customize button, I 31 
Customize option, 130 

D 
DA 1-Jandler fi le, 184 
Dantz Development Corp., 88 
data bits setting, 249 
data files, 10 
Datawatch Corp., 82, 94, 96 
date 

current setting, 105 
setting in System 6, 41-42 
setting in System 7, 4S 
wrong, 184-185 

dates 
missing/garbled in windows, 157 
reset to j anuary I, 1904, 157 

Dayna Communications, 97, 147 
Dead Mac Scrolls, Tire, 3, 76, 82 
dead Mac, 1 19 
default save location, 23 
desk accessories 

adding/removing in System 6, 54-55 
basic function, I I 

changes not saved, 188 
data in wrong fornlilt , 188 
name not on menu, 181 
not enough memory to usc, 18:1 
on menu in System 7, 27-28 
opening inside suitcase file, 182 
opening/managing multiple, 28 
programs to manage, 66, 89-90 
quit unexpectedly, 186 
storage files won' t open, 188 
too many open, 182 
too many to install, 134 
use in System 6 vs. System 7, 11 -12 

desktop file 
couldn't be created, 177 
description, 71-72 
rebuilding, 109-1 10 

desktop icons 
can 't be changed, 178- 1 79 
displayed at startup, 2U 
missing, 124- I 25, 127 

desktop items 
can't ali be opened/printed, 160 
can't movc/CO(>y, 171 
can't print from Finder, I 60 
double-clicking to open, 21, 24 
dragging, 21 
locking/unlocking, 35 
newer one at same location, 164 
not enough memory to copy, 166 
preventing changes to, 35 
selecting wrong one, 2 I 

storing inside System Folder, 165 
too many to drag, 171 

desktop window 
calculating folder sizes in, 157-158 
categories of information missing, 

155 
containing thousands of items, 158 
elates missing or garbled, I 57 
dates reset to j anuary l , 1904, 157 
files or folders missing, I SS 

not enough memory to keep open, 
16 1 

slow to open, 157-158 
viewing by size, I 58 

desktop 
colors change at random, 200 
displayed at startup, 20 
selecting/opening items on, 21 
window or Trash settings lost, 157 

destination disk, 130 
device driver, I S 

dialog box 
colors change at random, 200 
Mac beeps when click outside, 78 

direct-connect data cable, 9 
Directory Assistance, 93 
direC1ory dialog box 

description, 23-24 
when you open a DA, 187- 188 
docsn 't show fil e name, 189, 368 

Disinfectant, 95 
Disk First Aid, 18, 93, liS 
Visk Tools disk, 109, 120 
disk cache 

current size, 105 
description, 49-50 

disk clutter, 72 
disk contents, 21-22 
disk directory, 67 
disk fragmentation, 73 
disk organization, 22 
disk repair programs 

description, 18, 
seleC1cd products, 92-9-1 
using, I 15 

disk space, displaying, 48 
"disk unreadable," 146, 153 
disk window 

list view, 21 
opening, 21 
organization, 22 

disk 
can only be moved ... , 169, 170 
can't be erased (startup disk), I 78 
can't be put away, 153 
can't be used, error -192, 154, 192 
can' t copy to folder, 169 
can' t replace contents, 168 
couldn't be opened, 160 
damaged, 148 

Index 389 
format verification failed, 145 
formatting, 142 
Initialization failed, 148 
ini tializing, 142 
leaving empty space on, 67 
modified during copy, 172 
navigat ing, 23 
needs minor repairs, 148 
not a Macintosh disk, 146 
not enough memory to work ... , 152 
too full to record ... , 153 
unreadable, 146 

DiskExpress, 73, 92 
DiskFit l'ro, 88 
DiskMaker, 9 1 
DiskTop, 90 
docking station, 16, 17 
document types, 24 
document 

can't be opened/printed, 158, 159, 
16 1 

description, I 0 
"failed to print" message, 208 
not enough room to copy, 165 
opened at startup, 20 
printing, 24-26 
prints on wrong printer, 208 
prints with wrong font, 214-215 
saves to wrong folder, 19 1 
saving, 24 
viewing problems, 155-158 
won't print, 204-205 

DOS Mounter, 147 
double-clicking, 2 1 
Drive 7, 9 1 
Drivesavers, 99 
duplex setting, 254 

E 
Ettl)' Install button, 131 
Eas)• lnslll/1 option, 113, 130 
edition file 

deleting, 242, 245 
description, 241 
missing, 242 
moving, 245 

electronic mail services, 256 
error-checking routines, 249 
EthcrTalk fi le, 137 
expansion cards 

description, 6 
which are Installed, 105 

expansion slot, 6 
Express Modem, 269 
Extension Manager, 89 
extension conflicts, 56, 77, 122-123 
extension manager programs, 89 
Extensions folder 

contents loaded at startup, 20 
description, 14,58 
installing/removing items in, 57 
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extensions 

deact ivating, 57, 110 
description, II , 14 
effect on System fil e size, 66 
icon displayed when loaded, 20 
Incompatible at startup, 122-I 23 
installing/removing, 57 
managing, 89, 110 
modifying system software with, 56 
order In wtllch loaded, 20 
side effects or using too many, 56 
turning on/off, 110 
which ones you're running, 105 

external floppy disk d rive port, 8 
external speakers, 9 

F 
Fastback Plus, 88 
Fax Cover program, 272 
Fax Monitor Pref file, 272 
fax modems, 8 
Fift h Generation Systems, 88, 91 
file 

busy, 167, 168 
can't copy, 165, 167, 170 
can't delete, 175 
can't find with Open command, 189 
can' t leave In Trash, 175 
can' t move, 166, 175 
can' t openfprlnt, 159 
can't rename, 173 
copy-protected, 167, 168 
can't be wri tten, 171 
error message when saving, 190 
locked, 167, 168 
opening a backup copy or, 107 
saves to wrong folder, 19 1 
saving with a different name, 107 
utilities to open, 98 

file corruption, 77, 103 
file fragmentation 

description, 73 
repair programs, 92-94 

file repair programs, 18, 92-94 
file sharing 

determining whether ontorr, 106 
Identifying connected users, 106 
managing connected users, 106 
registering usersfgroups, 224 
sett ing access privileges, 226 
setting up, 223 
shared item status, 228 
sharing disks or folders, 225 
using control panels to adjust, 5 1 

File Sharing Monitor control panel, 228 
fil e transfer settings, 249 
FlleMaker Pro 

Align to Grid command, 350 
align ing objects precisely, 350 
Alignment command, 350 

changing field slzes, 347 
data not displayed completely, 347 
data slow to appear In fields, 345 
data/object doesn't appear, 3S4 
Define Fields command, 346 
entering data, 347 
entering Find criteria, 348 
entry options don't appear, 348 
entry options not displayed, 348 
Field Fonnatcommand, 348 
field covered by a gray box, 34 7 
field doesn' t display all data, 347 
field won't accept data, 347 
fields slow to display data, 345 
file can't be closed, 344 
file can't be found, 344 
fi le Is damaged, 344 
Find command doesn't work, 348 
guest users of a rue, 344 
Illogical calculations, 345-346 
Import Movie command, 354 
Importing records, 354 
label data creeps up or down, 353 
label data creeps up or down, 353 
limit of calculating pred sion, 346 
Lock command, 350 
lookup file, 344 
margins wrong size, 352 
new fields added to layout, 349 
no valid Find criteria, 348 
Number Fomra t command, 346 
0 1•erview command, 345 
pa.rt boundary overlapped, 354 
parts of two records displayed, 345 
pop-up menu doesn't appear, 348 
Preferences command, 349 
question ma.rk In a fi eld, 345-346 
question mark In fi eld, 345-346 
Quick11me movies In, 354 
Recover command, 344 
repairing flies, 344 
searching for symbols, 348 
selecting data in fields, 34 7 
selecting layout objects, 350 
Slide Objects command, 353 
sort order lost, 349 
storing a sort order, 349 
sub-summary part, 352 
sub-summary part, 352 
SUMMARY function, 351 
summary field not available, 351 
Unlock command, 350 
View As List command, 345 
vlewlng access privileges, 345 

Find command, 180 
Find Original button, 37 
Finder commands 

description, 32-40 
not enough memory for, 176 

Finder file, damaged/missing, 121 

Finder Preferences fll e, 157 
Finder utili ties, 18 
Flnde.r 

can't open more than one, 163 
can't switch launch , 162 
description, 11-13 
Mac can't load, 121 
older/newer than System file, 163 
printing not supported, 160 
replacing, 112-114, I 64 
selecting for startup, 39-40 
switch launching, 162, 163 
temporarily starting up with, 163 

floppy d isk drive 
description, 7 
dir ty, 147 

floppy disk 
formatted for DOS/Windows, 147 
icon doesn't appear, 149 
manually ejecting, 150 
stuck metal door on, 14 7 
won't eject, 149-150 

folder sizes 
calculating, 157- 158 
displaying In list view, 48 

folder 
can' t be left in Trash, 175 
can't be opened, 160 
can't be renamed, 173 
can't copy, 165, 167, 170 
can' t move, 166, 170, 175 
can' t replace contents, 168 
contains appUcMlons, 176 
contains Invisible Items, 175 
contains locked/busy items, 168 
deleting, 174-1 76 
navigating, 23 

Font Substirurion option, 214 
font 10 number 

confli cts, 215 
description, 214 

Font/DA Mover 
function, 11-12 
using, 54-55, 113 
ve.rslon out of date, 214 

Fonts folder 
ATM can' t find fonts In, 216 
description, 14 
installing/removing fonts, 56, 58 
limit of suitcases In, 217 

fonts 
bltmapped, 2 14 
downloading, 213 
fi xed-sized, 214 
adding/removing, 54-56, 58, 66 
jagged on screen, 214 
loaded at startu p, 17 
not available, 216-217 
not on menu, 214 
programs to manage, 66, 89-90 



foreign file format driver, 150-151 

Fractio11al Character Widtlls , 2.13-2.16 
FractiotJal Widtlls , 2.13 

freeze 
description, 80 
during startup, 12. 1 

forcing restart, 107 

spontaneous, 103 

FWil Software, 92 

G 
Gatekeeper, 96 

General Controls contro l panel 
using, 45 

wrong date/time, 184-185 

General settings in System 6, 4 1-42. 

generic documents, opening, 98 
Geneva font, p rinting with, 2. 12 

Get Editio11 Now button, 2.43 

Get l11(o command 
checking settings with, 104-105 

description, 32. 

using in System 6, 37 

using in System 7, 33-37 

windows, 33-34 

Get Privileges command, 2.29 
Golden Triangle Computers, 91 

gray shades, which di.sp layed, 105 

GrayShare, 282 

groups 

H 

Identifying, I 06 
limiting access by, 2.2.6-22.7 

registering, 224 

happy Mac icon, 19 

hard d isk 
can't change partitions. 144, 146 

can't rename, 15 4 
can't update driver, 144-145 

crash , 64, 103 

crashes at startup, 125-126 

damaged boot blocks, 124 

device driver, 9 1, 11 4 
driver can'l be installed, 145 

d river software damaged, 143 

external, 9 
failed test, 145 

format verification failed, 145 
head crash, 64 
icon doesn't appear, 124-125 

incompatible driver, 124 

internal, 7 
Mac can't find driver, 144 

Mac can't initialize, 144 

Mac unable to identify, 143 

Mac unable to select, 142 

no Mac volumes on, 144 

not initialized, 143 

partition, changing startup, 127 

partitioning software, 91 -92 

parlitions, 141 

reformatting, 91 
software can't recognize, 142-143 

unable to mount volume, 143 

Hard Disk Toolkit, 92 
hard disk boot blocks 

damaged, 12.2, 12.4 

error updating, 134 

hard disk driver 
damaged/ incompatible, 122., 124 

installing, 9 I 
problems with, 114 

replacing. 114 

u pdating for System 7, 114 
hardware failures, 76 

hardware problems 
avoiding, 61 -73 

codes fo r, 8 1-82 

funn y noises/smells, 76 

how Mac checks/reports, 76 
likelihood of, 75-76 

Hayes command set, 248 

Hayes Compatible Modem setting, 252 

headpho nes, 9 
!leap Tool, 18, 12.3 

lleapFixer, 18, 123 

~lclp!, 95, 104 

High Sierra driver, ISO 

icon view, 47-48 

icon, changing, 34 

icons, missing/garbled. 124-125, 12.7 

Il legal instruction." 12 1, 182., 192 
lmageWriter II 

colors overlap, 288 

mailing labels jam, 287 

paper jams, 287-288 
ribbon cam adjustmen t ring, 288 

spadng problems, 2 12 

words overlap, 212 

lmagcWritcr 
continuous paper o ff track, 286 

DIP switd1es, 285 

feed selection lever, 286 

GrayShare driver with, 282 

not selected or turned on, 208 

paper lhickness lever, 283 
pin feed vs. fri ctio n feed, 286 
ribbon worn out, 282-283 

top margin too big/small, 2.86 

won't print hairlines, 298 

wrong line spacing, 285 
Info windows, 33-34 

I n it conflicts, 56, 77, 12.2-123 

l11itialize button, 146 

!NiTpicker, 89 

I nits 
deactivating, 57, 110 

Index 
descriptio n , I I, 16 

incompalibllity, 122-123 

installing/removing, 57 

loaded at startup, 20 
managing, 89, 110 

391 

modifying syslem software, 5 6 
using loo many, 56 

which o nes you' re running, lOS 
In line Design, 88, 89, 90 

in put devices, 7 
111srall 1 disk, 113, 134 

i lls/all button, 11 3 

IllS/all Driver command, I I 5 
Installer disk 

can'l lake over, 132. 

contains o lder System fi le, 132 

descriplion, 130 

missing/damaged files o n, 131 

starting up with, 13 1, 132 

Installer program, 67, 113 

asks for anolher disk, 133 

can 'l install, 134, 135 

documents/scripl missing, 132 
error # -54, 135 

error updating boot blocks, 134 

how to usc, 12.9-131 

"lnslallatlo n failed," 135 
taking control of Mac, 131, 132. 

Installer scripl, 129-130 

resource error opening, 133 

ml"ing/damaged, 132 
Interface card, 6 
iniCrn.p l butto n , 107 

J 
James Engineering, 277 

K 
Kermit Tool, 250 

keyboard 
connecting, 8 
Mac won 't respond to, 119, 126 
non-Apple, 126 

sticky, 62 

Keyl'lnder, 93 

Kolor con tr ol pancl/cdev, 200 

L 
labels, won't p rint properly, 2 12 
LaCic, i.td ., 92 
LANSurveyor, 97 

laser printer 
Laser Prep software, 209 
slalls while ' preparing data," 210 

LaserWritcr 
corru pted driver, 28 1 

disabling startup page, 279 

downloads same fonts, 2 13 
grayscale printing, 281 -282 

GrayShare driver, 2.82. 
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Incompatible Laser Prep file, 209 
print density dial, 279, 280 
prints black smudges, 281 
prints blank pages, 279 
prints random spots, 280 
prints too dark, 280 
prints too lightly, 279 
prints unevenly, 280 
takes too long to print, 213 
using different drivers with, 209 
won't download fonts, 281 
won't print hairlines, 298 

LaserWriter Jig or llf, 281 
LascrWri ter Utility, 213 
Launcher, 13, 263 
list view 

changing, 47-48 
description, 21-22 

local echo setting, 249, 254 
locked fil e, deleting, 174 
locked folder, deleting, 174 
locked up Mac, 63, 107-108 
locking items, 35 
logic board battery, 119 
logic board diagnostic tools, 92-94 
logic board, 5-6 

M 
Mac II, h igh-density floppy disk, 261 
Mac llcx, over 8Mil of RAM on, 261 
Mac llsl 

sound fades In and out, 262 
speaker doesn't work, 261 
stuck keys on keyboard, 262-263 

Mac llvx, video card crashes, 277 
Mac llx ROM chip, 261 
Mac llx, over 8Mil of RAM on, 261 
Mac Classic, grayscale print, 281-282 
Mac Classic II, 400K disks In, 262 
MacLC 

10 Mil RAM not recognized, 261 
sound fades In and out, 262 

Mac Performa 
At Ease password, 264 
can't save with At Ease, 304, 324 
removable hard dlsk with At Ease, 

263 
Mac Plus 

BOOK noppy disk in, 260 
can't usc external hard disk, 259 
changing startup disk on, 260 
crashes with external hard disk, 259 
freezes at startup, 260 
no Startup Device cdev, 260 
no Startup Disk control panel, 260 
terminator on SCSI drive, 259 
won't print colors, 260 

Mac Portable 
ad justing options for, 51-53 
automatic sleep, 266 

caps lock unlocked after sleep, 265 
grayscale printing. 281-282 
printing takes forever, 265-266 
Rest mode, 266 
screen brightness, 52 
with SCSI device, 267 
won't go to sleep, 266 

Mac Quadra 
applications crash, 264 
applications run slowly, 264 

MaeSE 
BOOK floppy disk in, 260 
grayscale printing, 281-282 
won't print colors, 260 

Mac SE/30, over 8MB of RAM, 261 
MacBinmy option, 257 
Maci11tosll Bible Guide to System 7.1, Tire, 

44 
Madntosh diagnostic tools, 92-94 
Mac/11/osll User's Guide, 31 
MacSwap, 99 
MacTCP, incorrectly installed, 258 
MacTest Pro, 93 
MacTools, 73, 88, 93, 96 
MacUser magazine, 87 
MacWorld magazine, 87 
Mal:e Alias command, 38-39 
Master)uggler, 17, 28, 55, 66, 90 
Maya Computer, 99 
megabyte, 6 
memory available, 33 
Memory control panel, 49-50 
menu bar, moving, 46, 199 
Micro Doc, 99 
MicroPhone, 248 
m lcrophone 

connecting, 9 
selecting, 47 

microprocessor, 6 
Microsoft Excel 

UDIV/0!, 308 
HNA!, 309 
#NAME?, 308 
#NULL!, 309 
#NUM!, 309 
#REF!, 308 
#VALUE!, 308 
AilS funcrlon, 307 
Add 0>-erlay command, 317 
Axes command, 317 
can 't enter data Into a ceil, 305 
can 't save with At Ease, 304 
can't see chart Jines or bars, 317 
cell/ range name error, 318 
chart plots data incorrectly, 315 
Column Width command, 316 
column too narrow, 310 
combination charts, 317 
dates displayed as numbers, 310 
Define Name command, 312 

Display command, 309,312 
error values displayed, 308-310 
Emluate butto11, 313 
flies from older version, 304 
Find command, 318 
formatting options for charts, 316 
formula result wTOng, 306-309 
Go 1o button, 313 
HALTQ function, 313 
header or footer overlaps data, 311 
Hide command, 312 
hiding a macro sheet, 312 
Imported data bunched up, 319 
incompatible versions, 303 
justify command, 310 
label too long, 310 
loan payment too high, 307 
macro doesn't run, 312·3 13 
macro errors, 313 
macro recorder range full, 314 
macro sheet not open, 3 11 
Number command, 305, 309 
number In scientific notation, 305 
opening flies automatically, 304 
Parse command, 319 
Paste Name command, 318 
Paste Special command, 315 
plot11ng non-adjacent data, 316 
Print Preview command, 311 
range is deselected, 306 
range name, erro r creating, 318 
range names, pasting, 318 
relative formulas don't adjust, 306 
ltETURNO function, 3 13 
ROUND function, 305 
Row He/girt command, 316 
row/column titles don't print, 310 
Run Macro dialog box, 311 
Select Special command, 316 
Set Prill! Titles command, 310 
Set Recorder command, 314 
setting a macro recorder range, 3 14 
Step but1on, 313 
times displayed as numbers, 310 
Unprotect Document command, 305 
upgrading, 303-304 
zero values, 309 

Microsoft folder, 138 
Microsoft Word 

aligning data In columns, 296 
automalic hyphenation, 301 
Background Repaginatio11 option, 299 
backspacing over paragraph mark, 

293 
Based On menu, 297 
Bortler command, 298 
Calm/ate command, 300 
changing the defaul t font, 295 
copying styles, 297 
EPS Images In, 297 



Fast Save option, 290, 292 
files larger than normal, 292 
Frame commands, 294 
Go Back command, 293 
grammar checker, 300 
graphic changes line spacing, 29~ 
graphic distorted when resized, 297 
hairline border doesn't print, 298 
Nypl1etwtio11 command, 301 
Identifying standard styles, 297 
line break character, 293 
lines missing/spacing wrong, 292-

293 
lines wrap before right margin, 293 
MacPaint images in, 297 
manual line break, 293 
New Page command, 299 
no page break for a new section, 299 
page breaks different, 298 
pages print in reverse order, 299 
PICf images in, 297 
previous insertion point location, 

293 
Pri111 Preview command, 299 
Repagiuate Now command, 299 
Replace command, 30 I 
Sectio11 command, 299 
selecting one column In a table, 294 
sluggish perfonnance, 290 
spelling check on hidden text, :100 
style name duplicated, 296 
styles change unexpectedly, 297 
text reformatted when pasted, 295 
TIFF images in, 297 
upgrading, 289-290 

Microsoft Works 
alert when saving older Works file, 

356 
aligning objects to the grid, 363-364 
ATM with, 357 
Break Up command, 363 
breaking up a draw object, 362-363 
can't paste graphic to database, 365 
can't print a chart, 360 
can't select a database field, 36 1 
can't set tabs/Indents, 364 
captured text file is missing data, 365 
Copy Ruler Seltiltgs command, 357 
Copy Totals command, 362 
data prints outside labels, 361-362 
Decrease Size command, 357 
De{iue Chart command, 360 
editing part of a draw object, 362-363 
fixed-size fonts with, 357 
footnotes at end of each page, 358 
Fomwt Character command, 357 
Freeze Titles commands, 359 
lucrrase Size command, 357 
lusert Curre11t Dale command, 358 
Jusert Currem Time command, 358 

inserted date is wrong, 358 
Inserted time is wrong, 358 
/Oill command, 363 
locking a tool selection, 362 
macro doesn't work, 365-366 
macro files, multiple, 366 
Maaos 011 command, 366 
objects don't align, 363-364 
Open Macro File command, 366 
overflow area, 364-365 
paragraph fo rmats, 357 
Paste Ruler Settiugs command, 357 
pointer tool selected, 362 
l'rilll Preview command, 359 
printing a chart, 360 
printing part of a spreadsheet, 359 
repon totals, 362 
saving comm. documents, 364-365 
Slww Clipboard command, 362 
slows do•vn as you use it, 356 
Suap to Grid command, 364 
sort ing In the database, 36 1 
spreadsheet opens at cell A 1, 358 
spreadsheet page printing order, 359 
Style menu missing options, 357 
Touch Up command, 360 
typing In comm. documents, 364-

365 
unexpected macro result, 366 
U11group command, 363 
upgrading, 355 

Value and Category chart labels, 360 
MODE32 extension, 261 
modem port 

description, 9 
In usc, 251 

modem 
can't dial out or receive a call, 253 
connecting, 9 
description, 8-9, 247 
DIP switches on, 251 
disconnects immediately, 253-254 
non-working, 251-252 
troubleshooting, 251 -252 

monitor colors, choosing, 46 
monitor orientation, changing, 46 
monitor settings 

adjusting in System 6, ~ 1-42 
adjusting In System 7, 45-46 

monitor 
adjusting, 41-42, 45-47 
buzzes or crackles, 274 
connecting. 8 , 196 
crashes with more than one, 276 
distorted images on, 274, 275 
Identifying, 46 
installing w/control panel, 199 
menu bar not on, 199, 275-276 
pops and goes black, 274-275 
power not on, 273 

Index 393 
problems with, 198-200,273-278 
screen black with power on, 273-274 
screen on, but blank, 274 
selecting among multiple, 196 
selecting colors for, 196 
showing wrong colors, 275 
system error -25, 276 

Monitors control panel 
adjusting, 45-47 
not enough color options, 198-199 

mouse port, 8 
mouse 

button sticks, 120, 127 
can't move pointer off screen, 199 
cleaning, 126 
connecting, 8 
Mac won't respond to, 126 

moving a Mac while it's on, 64 
MultiFinder 

N 

basic function, 11, 16, 29 
selecting for startup, 39-40 
switching to Finder under, 29 
using multiple programs, 16, 28-29 

Neon Software, 97 
Net Minder, 97 
Network SuperVIsor, 97 
Network Vital Signs, 97 
NetWorks, 97 
New York font , printing with, 212 
Nollad Corporation, 275 
Norton Utilities for Macintosh, 73, 88, 93 
"Not a Macintosh disk," 146, ! 53 
Note Pad file, 15 

0 
On Technology, 98 
011e-sitlerl button, 146 
Ontrack Data necovery, 99 
Orphan Finder, 98 
"out of memory" problems, 67 
output devices, 7 

p 
parity setting, 249 
rn Tools, 18, 90 
periodic maintenance, 70-73 
peripheral cables, 63 
peripherals, 7 

choosing, 43 
connecting/disconnecting, 8-9, 62 
moving, 64 
placing too close together, 62 

Personal LaserWrlter LS or SC, 213 
phone line, dead/noisy, 253-254 
l'hotoCD disk Icon missing, 150-151 
PM~U chip, 50 
ports, 7 

Icons Identifying, 8-9 
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PostScript fonts, 18, 89 
power source, checklng. 6 1, 112 
power supply, bad, 119 
power switch 

nothing happens when on, 119 
when to use, 63 

Power Book 
adjusting options for, 51-52 
adjusting sleep mode, 5 1-52 
battery conditioning, 69 
battery conservation, 52-53, 69-70 
battery d ischarging, 69 
bat1ery life, 69 
blown fuse on logic board, 268 
crashes when waking up, 268 
crashes with SCSI device, 267 
displaying battery level, 51-52 
Don't sleep wlren plusged in option, 

266 
external monitor with, 53 
hard disk Icon disappears, 270 
keyboard too stiff, 270 
quitting communications programs, 

70 
RAM disk In, 70 
saving battery in, 69-70 
screen backlighting and battery use, 

69 
screen brightness, 52-53, 69 
screen dimming options, 53 
screen has permanent lines on It, 271 
SCSI disk options, 52 
SCSI ID, 52 
SCSI termination power, 267, 269 
sleep mode function, 16 
slows down network, 271 
speaker clicks, 270 
trackball not working, 270 
turning off AppleTalk on, 70 
turning off hard disk, 70 
using as an external SCSI disk, 52 
u tility software for, 18, 90 
video mirroring options, 53 
virtual memory use, 70 
with LaserWriter SC, 268-269 
won't go to sleep, 266 
won't recognlze SCSI device, 267 
won't run on battery, 268 
won't send a fax, 272 

PowerBook I 00 
Apple Talk Remote Access with, 268 
battery not fully charged, 267 
grayscale printing with, 281-282 
Network control panel, 268 
storage switch, 268 
won't run on battery power, 268 

PowerBook 170 or 180 screen dims, 270 
PowerBook Duo 

battery won't charge fu lly, 269 
can 't select printer port, 269 

docking station, 1 7 
Reset button, 269 
won't work with external modem, 

269 
l'owerBook control panel, 52-53 
Power Book Display control panel, 53 
PowerBook util ity programs, 90 
PRAM 

description, 6 
corrupted, 122, 124 
zapplng/Oushing, 115-116 

Preferences folder, 14 
Prl n t Error -98, 208 
printer access problems, 204-210 
printer Icon, not in Chooser, 205-206 
printer port, 8, 9 
printer 

connecting, 8 
name not In Chooser, 206-207 
not found during print job, 207-208 
which Is selected, 105 

prin ting 
AppleTalk off, 208 
A 1M can't find fonts, 216 
can't print at top of page, 211 
can't print shadowed text, 213 
characters don't look right, 214-215 
document didn't print , 209-210 
error # -192, 209-210 
error # -98, 208 
fonts on non-PostScript printer, 216 
garbled characters, 2 16 
Geneva or New York font, 212 
labels don't print properly, 212 
nothing happens, 204-205 
text/graphics chopped off, 211 
TrueType fonts substitu ted, 216 
uneven word spacing, 213 
wrong font, 214-215 

Print Monitor Documents fo lder 
corrupted, 210 
description, 14, 25 
printing documents to, 26 

Print Monitor, 
crashes durin g printing, 210 
description, 26-27 
displaying window for, 204 
location, l4 
not enough memory for, 210 
setting preferences for, 204 
spot11ng problems with, 203-204 

Prodigy, 249 
Programmer's Switch extension, 63 
programmer's switch, I 07, I 08 
Public Utili ties, 93 
Pu/JIIslrer Options command, 241 
publisher, 241 
Pyro, 262 

Q 
Quark.XPress 

angle of rotation, 338 
Bring 10 Front command, 341 
can't delete a box, 339 
can't duplicate a linked text box, 339 
Content tool, 336 
creating text boxes, 334 
default tool options can 't be reset, 

334 
defau lts for new documents, 334 
format changed by service bureau, 

342 
format d1anges in imported story, 

335 
Get Picture comm and, 336 
Get Text command is dimmed, 335 
im porting EPS Oles, 336 
linkages can't be duplicated, 339 
linking tool, 340 
linking o rder, 340 
margins are wrong when prin ted, 

341 
margins too small, 334 
Microsoft Word style sheets, 335 
Modify command, 336 
navigating in linked boxes, 340 
new documents use old defaul ts, 334 
new pages automatically added, 339 
no columns in new documents, 334 
no picture In a picture box, 336 
paper size vs. page size, 334 
Paste command won't work, 336-337 
1'1C f 2 graphics not displayed, 338 
printing a PostScript file, 342 
resizing graphics, 337 
restarting a print job, 342 
ro tating graphics, 338 
selecting with wrong tool, 335, 336 
Send to Back command, 34 1 
Sllow Measurements command, 338 
spadng between text an d box, 336 
style sheet didn 't transfer, 335 
text overnows a text box, 339 
text runaround doesn't work, 341 
thumbnails are too small, 342 
TIFI' files, 338 
Tiling option, 342 
Unilnkh•K tool, 340 
wrong printer selected, 341 
X Press Data file, 342 

question mark icon, 120 
QuicKeys, 14, 41, 90 
QulckMail, 90 
QulckTlme extension, 150-151, 193 
QulckTlme movies 

"insert disk" message, 197 
bad sound, 197-198 
controls, 194, 197 
description, 193-1 94 
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play jerkily, 197-198 
pointers, 194 

Radius video card, 277 
RAM cache 

adjusting In System 6, 4 1-42 
descript ion, 42, 47 

RAM disk, S0-5 1, 70 
RAM 

adjusting, 35-36, 49-50 
avoiding fragmentalion, 179 
description, 6 
fragmen ted, 179 
freeing up, 33 
how much available/in usc, 32-33 
how much programs request, 105 
largest unused block, 179 
leaving some unused, 67 
used by system sof1ware, 179 

Read Me files, 102 
Redux,8B 
remote computer, 250 
removable cart ridge hard disk 

fo rmatting, 9 1 
Icon doesn't appear, 15 1 
incompatible driver, 263 

Rescued Items folder, 291 
resource manager program 

checking if you have one, 182 
descript ion, 66 
selected programs, 89-9 1 

Restart command, 32, 39. 63, I 07 
restart ing 

during printing o r disk access, 64 
fo rced, 108 
methods of, 39, 107-108 
spontaneous, 186 

Retrospect, 88 
RFI, 62 
ROM 

description, 6 
Mac llx, 261 

RouterCheck, 98 

s 
sad Mac icon 

code numbers beneath, 80-82 
description , 76, 80-81 
displayed at startup, 12 1 

Safe & Sound, 93 
scanner, connecting, 9 
Scrapbook DA 

copying an Icon with, 34 
description, IS 

Scrapbook file, I 5, 16 
screen d isto rlion, 62, 80 
scrollback area, 256 
SCSI add ress, 10, 65, lOS, Il l 
SCSI bus 

description, 9, 10,65 
startup problems with, 122 

SCSI chain 
description, 9, 10 
unique addresses o n, Ill 
t roubleshooting, 111-11 2 

SCSI devices 
addresses of, 65, I OS 
checking cables o n, Ill 
connecting, 9 
terminatio n . Ill, 259, 267, 269 
turning on /off, 65, 111-112 

SCSI diagnostic tools, 92-94 
SCSI port 

descrlplion, 9 
Mac can't find drive on, 142 
number of devices connected to, 9 

SCSIProbe, 94, 105 
scleC11ng items, 20 
self-diagnoslic checks, 19 
Semi Editiou Now button. 243 
Serial l'ort Arbitrator, 251, 258, 269 
serial port expander, 251 
Serial Tool, 250 
Set Startup command, 20, 32, 39-40 
shadowed text won't print, 213 
Sllnriug command, 32, 37-38, 225-226 
Sharing Setup control panel, 223-224 
Shreve System s, 99 
S/1111 Dow11 command 

descriptio n, 40 
during printing or disk access, 64 
using, 63 

shut-down sequence, 63 
Sllverlining. 92 
sleep mo de, 16, S 1-53, 69 
Snooper, 94, 12 1 
Soft Solutions, 99 
softwa re incompatibilities, 77 
software 

avoiding problems with, 61-73 
compatible, 67-68 
original d isks from, 71 
third party, 17 
three basic types, 9-10 
upgrading, 67-68 

Sony monitors, 276 
'"Sorry, a system error has occurred," 79, 

121 
Sound control panel 

description/use. 47 
doesn't show a sound's name, 201 

sound input po rt. 9, 
sound level 

adjusting In System 6, 41-42 
adjusting in System 7, 47 
none, ZOO 
problems with, 200-202 
too low, 201 

sound ourput port, 9, 

Index 
sound type, selecting, 47 
SoundMaster, 55, 262 
sounds 

installing/removing. 55, 56 
programs to manage, 89-90 
recording, 196 

395 

recording on older Macs, 9 
wo n 't play properly, 201-202 
wrong o ne plays, 201 

speaker, no sound from, 200 
speakers. connecting. 9 
spilled liquids, 62 
"Stack collision with heap," 121 
Startup Device cd ev, 42, 110, 124 
Startup Disk control panel 

can' t change startup partit ion, 127 
description, 42, 49, 110, 124 

Startup Items folder 
description, IS, 20, 58 
installing/removing Items in, 59 
o rder in which items arc loaded, 59 

startup application 
can 't be set, 178 
damaged/incompatible, 124 
selecting/changing, 39-40 

startup disk 
changing, 49, 109, I l l 
contents can 't be replaced, 169 
ejected at startup, 119 
essential fil es on, 109 
if the normal o ne Is damaged, 109 
missing. 120 
no t enough memory to e ject, 152 
selcC1ing in System 6, 42 
selecting in System 7, 49 
using an alternate. 109 

startup document, lOS 
startup floppy disk 

disk repair u tility on, 109 
making, 109 

startup hard disk volume, 162, 163 
startup Items. 59 
startup problems, 119-127 
startup screen , changing. 20 
sta rtup sequence, 19 
startup sound, 19 
stationery document, 36-37 
stationery pad, 36-37 
StatusMac, 98 
stop bits setting. 249 
st orage devices, 7 
Straight X Modem method, 257 
StyleWriter 

bit mapped fo nts with, 284 
characters are b lotchy, 282-283 
characters missing, 284 
ClarlsWorks indents wrong, 369 
clicks when It picks up paper. 288 
DIP switches, 28S 
graphics wrong size, 286-287 
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grayscale printing, 281-282 
GraySh arc driver, 282 
ink cartridge empty, 282-283 
jagged o r lo w-resolutio n fo nts, 284 
print density uneven , 282, 
print too light, 282-283 
select light won' t come on , 282 
tiny print with gaps, 284 

using proper paper In, 283 
using with ATM. 284 
using with True Type fo nts, 284 
won't print hairlines, 298 
won't print shadowed text, 2 13 

Style Writer I, 284 
Subscribe To command, 24 I 

Subscriber Option! command, 241 
subscriber 

canceling, 2 43 
couldn't locate edition, 242 
data doesn't change, 242-243 
data has a d iffe rent format, 244 
descriptio n, 24 1 
non-modifiable, 242 

overwrites existing data, 244 
Suitcase II, 17, 28, 55, 59, 66, 91 
suitcase Iiles 

combining fonts o r DAs In, 54 
descriptio n, 54 
limit In Fonts folder, 2 17 

u n packing/deleting In Syste m 7, 55 
Sun Remarketlng 99, 
SuperCiock, 262 
SupcrMac Datal'rarne disks, 91 
Superset Utilities, 82, 94, 96 
surge protecto r, 11 2 
Switch Disk button, 11 3 
switch box, 25 1 
Symantec Antivirus for the Mac, 96 
Symantec Corporation, 93, 96 
Syquest caruldgc, Icon m issing, 151 
System fil e 

changing, 53-56, 1 I 2 
description, I 2 
minimizing, 66 
modifying, 53-57 

moving fo nts/sounds from old, 114 
multiple copies o n startup disk, 64 
optimum/maximum size, 66 
reason to replace, 72 
replacing, 112-114 

size rela ted to software errors, 66 
"System lile may be damaged," 121 

System Folder 
contents In System 6, 15-16 
contents In System 7, 13-15 

deleting old, 11 4 
description, I 2 
dragging to in stall , 136 
minimizing, 67 
multiple copies, 64 

operation under System 6, 59 
which is in control, 64-6S, 183 

System Folder folders, installing In , 58 
System Tools disk, I 13 

system beep 
description, 78 
when using Find command, 180 
when o pen ing DA or cdev, 184 

system crashes, preventing, 98 
system enabler 

description, I 5 
32-bit, 261 

system error message 
-25,276 
-90 opening application, I 92 
at startup, 107- 108, 121- 124 
description, 79-80 
ID numbers, 79, 82-86 
opening DA or program, 182, 192 
Resume or Continue button, 80 

system extensions 
adding/removing, 57 
deactivating, 57, 89 

description , 14, 20 
Incompatible, 56 

system heap 
description , 12 

enlarging, 18, 66 
progra ms to resize, 90 

system software applications, II 
system software files 

deleting, I 76 
Installer can' t delete, 13S 
locked, 135 

system software 
description, 10 
damaged/missing, 123 

T 

which version you're running, 104 
essential compon ents, 12 
Installing from startup d isk, 130 
Installing o lder version, 132 
missing files at startup, 123 

replacing, 112-114 
too much under System 6, 123 
utilities, 11 

technical support, 117 
Technology Works, 98 
Tech works Net Utl llties, 98 
temp files, 172 
terminal settings, 249 
terminal tool, 256 
Text wlt/1 Line Breaks option, 256 
time 

adjusting in System 6, 41-42 
adjusting In System 7, 45 
determining current setting, 105 
wron g afte.r you reset It , 184-185 

Top 0( Fonn button, 286 

T.rash 
can't m ove off the desktop, 172 
emptying 37, 174 
maklng aliases fo r, 172 
Rescued Items folder in, 291 
warning about, 3 7 

ITY tool, 256 
Thesday Software, 98 

Two-sided button, 146 

u 
unexpected error, 187 
"Unimplemented core routine, • 182, 192 

Update Driver command/button, 115 
users 

limiting access by, 226-227 
registering, 224 
which are registered, 106 

Users & Groups control panel, 224 
Utilities J disk, 120 

v 
VGA monitor, 277-278 

video card, 6-7 
video diagn ostic tools, 92-94 
video memory, changing, 46-4 7 
video port, 8 

video 
how Macs display, 195-196 
problems with, 189-200 

Views control panel, 4 7-48 
View m enu, 22 
Vlrex, 96 
virtual m em ory 

current status, 106 
description, 50, 70 

virus-checking conflict, 13 1 
VirusBiockade II Ltd ., 97 
VirusDetcctive, 96 
viruses 

description, 77 
checking for, I 14 

VRAM (video RAM), 196 

Vf10 2 tool, 2S6 
Vf320 tool, 256 

w 
Welcome to Macill/os/1 box, 20 
window, ch anging views, 47-48 
window, colors wron g, ZOO 
wir es, broken, 63, 111 
Word Temp flle, 291-292 

X 
XModcm Tool, 250 
X Modem Tool, upgrading, 257 
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